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Manipulating Data & Named Ranges

Paste Special Techniques

Paste Special

e Open a workbook called Paste special 01.

e Selectthe cell(s) containing the data you wish to copy, in this case the range A2:D6.
e Press Ctrl+Cto copy the range.

e Selectthe cell you want to paste the copied data into, in this case cell F2.

e Click on the down arrow under the Paste icon (on the Home Tab).

|'..E!E| Hq =
[ |
- Home
e
| j 6} Ariz
o |
avs 8 ,f | B
:{Cllpboard 'T-.‘

This will display a range of Paste options. In this case select Paste Values.

|'..E!§'.I IH " = .i.:‘J Ny
[ |

Home Insert Page Layout Formulas D

-l -8 W=

Eﬁ As Picture

e You will notice that just the values are pasted, without any of the formatting that was
applied to the original table.
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[ A LB | C e B b B G & | H ] I | d

1|

2§ Sales by Region Jan Feb Mar

3 Marth 23958 17948 18948

4 ‘South 34984 16999 25937

5 East 19849 13937 24937

6 West 29949 12837 14736

7

e Save your changes and close the workbook.

Transposing data
e Open a workbook called Paste special 02.

e Selectthe cell(s) containing the data you wish to copy, in this case select the range
A2:D6.

e Press Ctrl+Cto copy the range.
e Selectthe cell you want to paste the copied data into, in this case click on cell F2.
e Click on the down arrow under the Paste icon.

R [

& Calibri
Paste - B 7 U -
e |l u -
IE Paste

Formulas

Paste Values

Mo Borders
| Transpase

Paste Link
Eﬁﬁ Paste Special...
['ﬂ Paste as Hyperlink

Picture

e illustrati

1

2 Sales by Region Jan Feb Mar Sales by Region |North |South |East |West
3 Morth 23,958 17,948 18,948 Jan 23,958| 34,984| 19,849| 29,949
-tl ;South 34,984 16,999 25,937 Feb 17,948|16,999|13,937| 12,837
5 |East 19,849 13,937 24,937 Mar 18,948 25,937| 24,937| 14,736
6 | West 29,949 12,837 14,736

=

e Save your changes and close the workbook.
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Importing a text file and delimit by comma, space or tab

Importing text and delimiting by space, comma or tab

e Click on the Office Button icon (top-left of your screen) and select the Open
command. The Open dialog box will be displayed. In the Fles of type section click
on the down arrow and select All Files.

IR FUMCTION MPY, LS FEEILIME WORKBOOK DATA 02 5L FE|PROTECT WORK
< il |
File name: | v |

Files of bype: | )l Ewcel Files (% f®; * xlsw; * xlsm; *.lshy * larn; * by # xlbrn; *.dds; *.odk; * e * bl *.mhtjr

~
Al Excel Files {*,x*; *.xlsx; *.xlsm; *.xlsh; *.xlam; *.xclbx; * ot *.ds; *.xlk; *.him; *.heml; *.mke;

Excel Files (%, xF*; *.xsx; *.xdsm; *.xlsh; . xlamy *deey *ocltrng #.ds; *.da; *,oxlk; *xdm; ) T

Al web Pages (*.htm; *.html; *.mht; *,mhtml)

¥IL Files . xml)

Text Files (*.prn; *.bxk; *.cow) b

o Selectatext file called Import text.txt. This file is delimited by tab stops.

EFUNCTION YLOOKUP, ¥L5
EHIDE. xls

m Impark kexk, bxk
€ kEvBOARD jng
(15 PR

e Click on the Open button. You will see the Text Import Wizard (Step 1 of 3) dialog
box, as illustrated.

SAMPLE

FOR USE AT THE LICENSED SITE(S) ONLY
© Cheltenham Courseware Pty. Ltd. 1995-2010 www.cheltenhamcourseware.com.au




Excel 2007 Intermediate - Page 8

Text Import Wizard - Step 1 of 3

The Text Wizard has determined that wour data is Delimited.
If this is correct, choose Mext, or choose the data tvpe that best describes vour data.

Criginal data type

®:

() Fixed width - Fields are aligned in columns with spaces between each Field,

Choose the file bype that best describes your data:

- Characters such as commas or tabs separate each Field.

Statt inmport at powe |1 2 | File arigin: |Win|:||:|ws (BMSI)

Preview of file C:\Documents and SettingsiDavid MurrayiMy DocurmentshExcel 200, Import ket bzt

lFirst namelfecond namelCompany nameldCountry
ennisl:l HastertOConputer Svystems0OUE

ancyld Pelosi0OIT Training SolutionsO0S4
eorgel RadanowichOThe Work PlacedBrazmil
hepastindArrietelTraining SolutionsOIceland

I

|i€

Bacl [ Mext = ][ Einish

J

¢ Notice that the dialog box has two areas, the upper referring to choices you can
make, the lower showing the data you are about to import. The wizard looks at your
source data and the original file format and determines whether it is delimited or not.
You can choose to alter this decision if you wish. In this case Delimited text is

automatically detected.

e Click Next and the Text Import Wizard (Step 2 of 3) dialog boxis displayed. The
upper half of this box allows you to select the required field delimiter. The defaultis

Tab.

SAMPLE
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Text Import Wizard - Step 2 of 3

This screen lets you set the delimiters vour data contains. You can see how your bext is affected in the preview
belaw,

Delimiters
Tab
[] semicalon [] Treat consecutive delimiters as one
|:| Comma
|:| Space

[] other: l:l

Text qualifier; w

[aka preview

irst_name Fecond name Conpany hname

ountry L
ennis Hastert omputer Systems =
anciy Pelosi T Training Solutions T84 b
EOY e RBadanovich [The Work Place razil
qustin rriete raining Solutions celard

E

[ Cancel ][

| [ Ensh |

¢ The delimited textis displayed at the bottom of the dialog box.

e Click on the Next button. The Text Import Wizard (Step 3 of 3) dialog boxis
displayed.

SAMPLE

FOR USE AT THE LICENSED SITE(S) ONLY
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Text Import Wizard - Step 3 of 3

This screen lets you select each column and set the Data Farmat,

Column daka farmat

[ata preview

() Do not jmport column (skip)

(%) General , . :

General' converts numeric values to numbers, dake values to dates, and all
O Text _ remaining walues o text,
() Dater | MDV | Advanced. ..

Ceneral Ceperal
LEVEEE econd nane Conpany name Country #
Hastert Computer Systems LTE
Palosi IT Training Solutions [JT54
Badanowvich [The Work Place Erazil
EX Lrriete Training Solutions Toeland w
< >
I Cancel ] ’ < Back ]

You can select the data format for each of the columns. You can also decide
whether you wish to import a column or not. In this case click on the Finish button to
import the text into your spreadsheet. The data should be neatly separated into
columns, as illustrated below:

A B E D
1 First_name Second_name Company_name Country
2 |Dennis Hastert Computer Systems UK
3 MNancy Pelosi IT Training Solutions  USA
4 |George Radanovich  The Work Place Brazil
—Agustfn Arrigie Training Solutions geglceland
6 |Ruthy Dreifuss, IT Here /| Spain
7 |Louls Dumas| IntﬂnEt_‘SqutiorE | France
Walentino  Gravani\ \  Gates Training /| (Germany
5 |Birgity Wilson UK Training Solutions UK __|_
10 | Tom Feeney |\ Murray Training [ UsA [
Ernst’ /| Mach _LJorESolutiins UK [
12 Christopher Cox Reed Consultants Spain
13 |Tom Delay London IT Centre UK

aa

Save your data in Excel Workbook format. To this click on the Office Button and
select the Save As command. When the Save As dialog boxis displayed, use the
Save as type section of the dialog box to select Excel Workbook. Use My

Delimited File as the file name.

FOR USE AT THE LICENSED SITE(S) ONLY
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Filz name: Impart ket bxk 4

Save a5 BYPE! | Tyt (Tab delimited) (*,bxt) ~

\Ex orkbook [, xlsx)
Ex cro-Enabled Warkbaook (*,xlsm)
Excel Binary Workbook (¥, xlsb)
Excel 97-2003 Workbook {*, xls)
%ML Data (*,xml)
Single File Web Page *.mht; *.mhtml} b

e Close the workbook.

Named ranges

What does naming a cell range mean?
e We have seen that cells can be referred to by their location references:

Examples of single cell references would include.
C1

AA23
V16
Al

Examples of referencing a range of contiguous cells would include.
Al:A6

B3:X3

B16:F20

o lItis also possible to name cells and ranges so thattheyecan be referred to using
meaningful names, such as ‘sales’.

ltis“much easier to_ understand a formula such as:
=unit_price*no_of _units

than a formula of the type shown below.
=A9*B84

Rules for naming cells and ranges

e Range names normally begin with a letter or underscore character.
e Range names must NOT contain hyphens or spaces.

e Range names should be limited to 255 characters.

FOR USE AT THE LICENSED SITE(S) ONLY
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Bear in mind that names of 10-15 characters in length will be visible in most drop-
down menus.

Naming cell range(s) in a worksheet

Open afile called Named ranges 01.
We are going to name a range for the Quantity Sold.

Select the cell(s) to be named, in this case cell B10. Click in the Name Box with the
mouse and enter the name you want to give to the cell(s), in this case
Quantity_Sold, and press Enter. (If you see an error message, this is because you
did not place an underscore character between the words Quantity and Sold):

Quantity_Sold - fe | =sum(Ba:B9)
A B C D E
Sales for March

Sales Person Quantity Sold Price per item
Myah 52.25
Carla
Rowan
Gina
Shrikrishna
Kayo

Total quantity sold | 271

Total value of sales

W 00|~ L R —
Fd 20 O LS LR L

= | b [ =k
Mo = =

| =k
= |

We are now going to name a range for the Price per Item. Highlight and select the
cell(s) to be named, in this case cell D4. Click in the Name Box with the mouse and
enter the name you want to give to the cell(s), in this case Price_per_item, and
pressS)Enter.

TIP: If you seg an error message, this Is because you did not place an underscore
character between the words.

FOR USE AT THE LICENSED SITE(S) ONLY
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Price_per_item - I | 52.25
A B c D ;
1 Sales for March
2
3 Sales Person Quantity Sold Price per item
4 Nyah 3 I 52.25!
5 Carla 5
6 Rowan 3
7 Gina 6
8 Shrikrishna 8
9 Kayo 2
10 Total quantity sold 27
11
12

Total value of sales

| =
o

Named ranges within formulas

First click on cell B13 and enter an equals symbol (=).
Click on cell B10 and enter a multiply symbol (*).
Click on cell D4 and then press the Enter key.

Click on cell B13 again and notice the formula in the Formula Bar. As you can see
this makes the formula much easier to understand:

s 7 B [ U -||td || &A= E E|FFE
Clipboard ™ Font ] Alignment
B13 - f | =B10*Price_per_item
A B E D

1 Sales for March

Navigating through workbooks using named ranges

Having defined a setof named cell ranges, click,the, dewn arrow to the rightiofithe
Name Box andsselectthe named cell/range you wish to go to from the drop down
listthatappears. Try\going to bath/ranges thatyou have named.

. 7 _—= —
Clipboard ™ Font

Ios O

Price_per_item

Quantity_Sold th
2

Save your changes and close the workbook.

FOR USE AT THE LICENSED SITE(S) ONLY
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Creating named ranges automatically based on cell values
e Open afile called Named ranges 02.

e Click on cell B2, which we wish to name the cell using the name Tom.
e Click on the Formulas tab and then click on the Define Name icon.

| Formulas | Data Review View Developer

ﬁ Lookup & Reference ~ ﬂ |~51 Define Mame; 'J

L T

The New Name dialog boxis displayed and as you can see, has automatically
picked up the name Tom.

Mew Name @

Mame: | |
arope: | Warkboaok w |
Cornrmenk:
Refersto: | _cheet114E$2
[ 8] 4 ]’ Cancel ]
=

e Click on the OK button to complete the naming of the cell.
o Repeatthese actions so that cells B3:B5 are also named with the relevant person.

Name |
L ﬁj More Functions = Manager

Defined Names J

e The Name Manager dialog boxis displayed

FOR USE AT THE LICENSED SITE(S) ONLY
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Name Manager
(e ) (o ) o= ]
Mame Yalue Refers To Scope Camment
=1 Carla 23,856 =Sheet1 14643 Workbook
=1 Gina 41,948 =Sheet1 14645 Workbook
=5heet1 15654 Warkbook
=1 Tam 34,948 =sheet 114642 Wiorkbook

e Selectthe name you wish to delete, in this case Nyah and then click on the Delete

button. A warning dialog boxis displayed, click on the OK button to confirm the
deletion.

e Save your changes and close the workbook.

Sub-totaling

Creating subtotals
e Open aworkbook called Subtotals.

o First, sortthe data in ascending order, using the data in the Sales Region to
perform the sort.

e To do this click on Data tab. Click on cell A3 and then click on the Sort Ascending

icon.
P | Data | Review v
Connections:(|(a 1| fa 7] |

&4/ [T
Properties z | JE_L .L

Sort

Edit Links &l s |I |
ections 51

=4 Data Validation

== |
roperties ",:, Reapply =k - {F Consalidate |

il Sort Filter 7 Textto Remowve ) Group Ungroup iSuhtuiall |
dit Links S Advanced || Columns Duplicates L5 What-If Analysis ~ . -
ttions Sort & Filter Data Tools | Cutline g |

This will display the Subtotal dialog box.

FOR USE AT THE LICENSED SITE(S) ONLY
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Subtotal

At each change in:

|Sales R.egion w |

Ise Funckion:

|Sum V|

Add subkotal to;

[ ]5ales Region
[ ]3alesperson

5 Value

Sales

Replace current subkotals
[ ] page break between groups
Summary below data

[Eemwe Al ] L DK, ] [ Cancel ]

e Click on the OK button. You will see the data subtotaled as illustrated:

| A9 MO
[1]2]3] A | B | C | D
1
| 2 |
. 3 Sales Region Salesperson Sales Value
[ [ - | 4 East MNuo 38,953
5 East Anora £9.849
6 East Wisia 43,965
- | T East Rowan 20,852
=] | & EastTotal 163,619
- | 9 [Morth
10
1
12
13
)
17 'South Total
[ - | 18 West
15 'West
20 'West
© | 21 West
=] | 22 West Total
= 23 Grand Total 598,822
24

FOR USE AT THE LICENSED SITE(S) ONLY
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Removing subtotals

¢ Click on the Subtotal icon and within the dialog box displayed, click on the Remove
All button.

Replace current subtotals
[] page break between groups
Summary below data

[F'_uamove all ] L QK J [ Cancel J

¢ Reapplythe subtotals once again and the close the workbook, saving your data.

SAMPLE
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Templates

Using templates
e Click on the Office Button and select the New command.

e This will display the New Workbook dialog box. In this case select the Installed
Templates command (on the left of the dialog box). You should see the following
displayed.

My Wik Espeodi

Blank ana recent

I o Templates | Installed Templates

Wy temoiater..

Kew from guirting — — i Mo

Micreas Dffice Dnling | -

Featuied |! 2 F
¥

agendan

Budgerts

Caehdirt

Exgurnie repoity . Yoaur Company Mamas

Fitsiiii U FEEE.

— 3
Vreenteiea I e B ) b S D
1
Vreohen -3
=== R T

Lty

Pany
LELLT

Ppchsie sadery
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'ni-l - R i R Blbrigtatemamtl  Msranch Eacal - T
= pams | s Fige Ligind Primids Bals  Aewiew View Dreriiper @ -0 X
= = - ! SR s I, oy S o =
B : CRTmMT  s[U + AT [ amigiiEbe] S| canem . hﬁ" 59 :r":ﬂm' ; #! ﬂ
M g BRSNS S (R (S Rl - S+ | (D) Pemet | 2+ Py St
Chjsbeaid - Panl i alighmasit 1z [T i U (1 Listing
% SRR S ——— R Bk it s e iy i _m._..r___ prag— =
o ] C o E F G H | [}
| Lrassmait V. Tatar watement namber Bill Ta: Mams
i ] Doaa: June 18, 3067 Commpany Mame
(3] Cusimemss 10 nbar cusiomes I Sirwe Aridrei
L1} Adderia 1
L Cip, 5T 2P Code
B
i Doty = | Type = Invelen @ =« Duscription = | Amownt |« Payment + Balancs | = |
[ ]
1% Tetd H
17 Mamani
ia ]
19
10
Fil Cantmner Fdamn  Faler (udosses name
1 Cantneney 10 Escer cuviomer 1D
i | Sramamasny & Tiaker Balemant Aurmles
rL Dt Jane 18, 2007
W = &gy D #0100
Hh F Eniv b,
17
Hescon g Sraveent S ol 1M

o Take a little time to examine the workbook that has been created for you. You can
click on the various fields within the document. You can enter values for billing items
and totals will be calculated automatically. After a short time experimenting, save the
workbook as My Billing Statement, and close the workbook.

¢ |If you have time take a look at some of the other installed templates.

Creating templates

ok not a t
onthe O utton
As dialog box.

and

File: name: Make inko template, xlsx

Save asEYPe | Eycel Workbook (*,xdsx)
Single File Web Page (*.mht; *.mhtml)

Web Page (%, htm; *, bkl
Exicel Template (*, xlkx)

= k)
Excel Macro-Enabled Template (¥, xltm)
Excel 97-2003 Template (*,xt)
Text (Tab delimited) {*.txt)

[ =

<
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¢ Click on the Save button to save the template.
e Close the template.

e To use the template, click on the Office Button and then click on the New
command. Selectthe My templates option.

New Workbook

Templates
] I Blank and recent }

|_l Installed Templates
) | My templates... |

Blmsss Ewmmm maciodim

¢ You will see a dialog box displaying your template file.

My Templates |

EmE

Presview

e Click on the Monthly Sales template and then click on the OK button. Anew
workbook will be created, based on the template.

NOTE: You have not opened the template file, you have created a new workbook,
based on the template file.

You can fill in details on the workbook (just make up some data) and then save the

e Inthe Fles of type section of the dialog box, select Templates.
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File name:

Files of bypet | Tomplates ¢, xlbx; * xlbm; *,xIE)

Microsoft Excel 4.0 Workbooks (¥, xlw)
Worksheets (¥, xlsx; * . xlsm; *.xlsb; *.xls)
Workspaces (%,

Templates (%, xltx
Add-Ins (*.xlam; *.xla; *,xID
Toolbars {*. xlb)

(=% =

Tools =

% [

e Selectyour template file and you can now make changes to the actual template file.
Add your name next to the ‘name’ field and re-save the file.

NOTE: Anychanges that you make to the template file will only affect new
workbooks that are created using the template. Anyworkbooks that were previously
created based on the template will remain unaffected.

e Create a new document based on your template and this time you will see that your
name is now automatically displayed within the new workbook. Close the workbook
withoutsaving your changes.

SAMPLE
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Formatting & Display Techniques

Cell Styles

Formatting tables
e Open a workbook called Cell styles.
e Selecta cell within the data in the worksheet.

¢ Click on the Home tab and from within the Styles group click on the Cell Styles
icon.

=i
Conditional Format Cell

Formatting = as Table ~ Styles ~
Styles

e This will display a drop down from which you can select a style to applyto the
selected cell(s).

| Good, Bad and Meutral b
Maormal Bad Good MNeutral
Data and Model

Calculation Check Cell Explanatory ... |Input Linked Ce Mote
Output Warning Text

Titles and Headings
Heading 1 Heading2 Heading 3 Heading 4 Title Total

Themed Cell Styles

[ IBE 8

Comma Comma [0] Currency Currency [0] Percent

(]| New Cell Style...
|é| Merge Styles...

o Experiment with applying different formatting styles to different cells. Remember
that you can selectmore than one cell at a time by keeping the Ctrl key pressed as
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you click on cells. When you have finished experimenting save your changes and
close the workbook.

Table Styles

Formatting tables using table styles

e Open a workbook called Table styles.

e Select the table within the worksheet.

e Ifnecessaryselectthe Home tab and then click on the Format as Table icon, within
the Styles group. This will display a drop down from which you can select a style to
applyto your table. Experiment with applying differentstyles and look at the effect it
has on your table.

- '- L R Eir&h

e Conetional | Format | Cell | Sort & Find &
Ik  Farmatting = a1 Tahle = Shen~ | E1Furmat - | 2= Filler= Sebect

e An example style is shown below.

Sales persorg Sales of new {:HIB Sales of new vandzl

James 4 5
Josh 3 3
Sue 8 ¥
Diana 5 5
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When you have finished experimenting save your changes and close your
workbook.

Conditional Formatting

Formatting cell ranges using conditional formatting

Open a file called Conditional formatting. This workbook contains details for sales
over a 3-month period. We wish to highlight all sales over 50.

Select the range of cells to which you wish to apply conditional formatting. In this
example, the range would be C6:E13.

James 23 45 65

Paul 34 76 45
Lou 12 33 36
Peter 43 53 b4
Josh 23 76 43
Mary 65 23 25
Fiona 34 43 23
Alison 76 12 33

Click on the Home tab and then click on the Conditional Formatting icon (within
the Styles group).

-I 1 =1 ]

E:'léj T ¥

Conditional | Format Cell

Formatting ~'as Table = Styles =
Styles

Thiswill displaya drop down list. In this case click'on Greater Than from the
submenu dis played.
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genset || X - ﬂ Eﬁ
3"" Delete ~ @‘ ‘
e Sort & Find

Formatting ~ | as Table = Styles = IEE_J Format ~ || 27 Filter~ Selet

L= =" L
-||_.'._—T§L Highlight Cells Rules » | —i| Greater Than... |
y \_% Top/Bottom Rules » @ Less Than... l

] |':-'L Equal To...

0
k|| ':J'J Text that Contains...

Ej HNew Rule.., H—t .

i | 1 A Date Occurring...

LE,'; Clear Rules ¥

[[3]| Manage Rules.., =

Lrj . = - | =i| Duplicate Values...
More Rules...

e This will displaythe Greater Than dialog box. We wish to highlight all values over 50
so we need to enter the number 50, as illustrated.

Greater Than

Format cells that are GREATER THAN:

50 with |Light Red Fill with Dark Red Text v |

L Ok J[ Cancel ]

ing th Il be [ Is over

or
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Greater Than

Format cells that are GREATER THAN:

50 with |Light Red Fill with Dark Red Text |+

Light Red Fill with Dark Red Text
Yellow Fill with Dark Yellow Text
Green Fill with Dark Green Text
Light Red Fill

Red Text

Red Border

Custom Format...

¢ When finished click on the OK button and you will see that all cells containing values
over 50, are now formatted, as requested.

Sales person January February March

James 23 45 65
Paul 34 76 45
Lou 12 33 36
Pater 43 53 64|
Josh 23 76 43
Mary 413 23 25
Fiona 34 43 23

Alison 12 33

¢ If you have time investigate some of the other conditional formatting options. When
you have finished experimenting save your changes and close the file.

Custom number formats

3 | For 2005 For 2006

4 Income 639,938 485 938
b Expenditure 498 384 548 857

6 | Balance| 141,554 62919 1

T

¢ Rightclick on the selected cells and from the popup menu displayed select the
Format Cells command, which will display a dialog box.

e Selectthe Number tab.
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e From the Category section of the dialog box, select Custom.

e Within the Type section of the dialog box, select a format code similar to that shown
below:

# ##0:[Red]-# ##0

Format Cells

Murnber | Alignment || Font || Border || Fill || Protection
Categoty:
General Sample
Number 141,554
Currency ’
Accounting Type:
Datke
Tirne #, 440 [Red](d, £40)
Percentage General ~
Fraction a0 |
Scientific 0.00 =
Text #4880 L
SEecial #,##0.00

#,4#0.00_;[Red]i#, #4#0.00)

$at, R0 ($#, #H0)

$, 220 0 [Red](b#, 2200 ]

Delete

e Within the format code, change the word Red to Blue:

Tyvpe:
#,#20_[Blue]i#, ##0)

General

0

0,00

#, 820

#,##0.00
#2008, 2#0)

[

[ £

e tive bal for the year 2006 will be displayed

e Save your changes and close the workbook.

Freezing row and column titles
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Freezing the top row
e Open aworkbook called Freeze titles.

¢ Inthis example, we have column titles, which in this case, are the months of the
year, and row titles, which relate to ‘stock numbers’. The main data area displays
the number of each stock type sold in a particular month:

A | B | ¢ | o | E | F [ & | H | 1
1 | Stock Number January February | March April May June July Auqust
2 456 3 | G 5] a8 4 4 5
3 465 5 5 7 g 3 1] 5 3
4 474 g ] g 3 5 g 7 g
5 483 3 7 9 ) 7 3 g 3
] 492 5 4 g 7 3 5 9 ]
7 501 7 3 5 3 5 7 g 7
] 510 3 5 7 2] 9 3 7 3
9 519 6 5 3 5 g 6 6 B
10 528 g 4 6 7 6 3 6 g
11 537 7 2] ] 4 g B g 3
12 546 9 7 7 3 3 7 3 ]
13 555 g 3 B 5 B 3 B 7
14 364 1] 2] G 7 7 G 7 3
15 573 8 7 8 2 3 5 3 5]

e If we scroll down the page we would soon see the following. As you can see the
column titles are no longer visible.

[ R Ry R RN Ry A AR wu ]
(I3 =y R A~ e R 3 ]
1Mo W ~ o 00w oo |
Vb = M 00 L)~ o) [T
(A R R o R SN B |
[REsp AR SRR ay RESRRRCN RN uy Rl S N wa ] iy
(R mnRny Ry Rt R wa AT w n RVl b
O W O L 0| —

e tthe Freeze Panes

i

= arrange Al . Hide FEH

l@ Freeze Panes - | ] Unhide | #4
Window

om 100% Zoomto
Selection

Zoom
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e You will see a drop down list of options. Click on Freeze Top Row.

FFH Freeze Panes=| ] Unhide

Save Switch
4 | workspace Windows

Freeze Panes

Keep rows and columns visible while the rest of
the worksheet scrolls (based on current selection).
Freeze Top Row

Keep the top row visible while scrolling through
the rest of the worksheet.

Freeze First Column

Keep the first column visible while scrolling
through the rest of the worksheet,

= o T -

e Now when you scroll down the page the top row containing the column headers
remains frozen and visible at all times.

e To unfreeze the pane, click on the Freeze Panes button and select the Unfreeze
Panes command.

= - | ) | Save 5
Eﬁeeze Panes =| ] Unhide | +14 | workspace Wini

== Unfreeze Panes

=‘ QEE Unlock all rows and columns to scroll |
through the entire worksheet,

| Freeze Top Row
% Keep the top row visible while scrolling

through the rest of the worksheet,

—— Freeze First Column
EEE Keep the first column visible while scrolling

through the rest of the worksheet,
T T T % T o

Freezing the first column

¢ Ifwe now scrall to the right, we will see the following. The row titles are no longer
visible:

February
=]

o Mmoo e

n o3 L~ 3 00 w0 00
pa R apRina QR R ap RSN Rt R uy]
DWW MW O
0o o

e To freeze the first column, click on the View tab and from within the Window group
select the Feeze Panes icon. Click on the Freeze First Column command.
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= Mananyc M LT

FFH Freeze Panes (] Unhide

e Freeze Panes

Keep rows and columns visible while the rest of

. the worksheet scrolls (based on current selection).
Freeze Top Row

Keep the top row visible while scrolling through
the rest of the warksheet.

Freeze First Column

‘ Keep the first column visible while scrolling
through the rest of the worksheet,

IFE= S
Save Switch
4 | Workspace Windows ~

e Ifwe now scroll to the right, the row titles will remain visible, as illustrated:

A c | H | 1
1 [ Stock Number| June July August
2 456 4 4 5
3 465 0 5 3
4 474 8 7 g
5 483 3 a 3
B 492 5 9 5]

e To unfreeze the pane, click on the Freeze Panes button and select the Unfreeze
Panes command.

Freezing the top row and the first column at the same time

e Click on cell B2 and then click on the View tab and from within the Window group
selectthe Freeze Panes icon. Click on the Freeze Panes command.

PLE

You will find that the top row and the first column have now both been frozen.
e Save your changes and close the workbook.

_ | | Save Switch
@ Freeze Panes =| | Unhide | #14 Workspace Windows

Freeze Panes

Keep rows and columns visible while the rest of

Hiding and un-hiding rows and columns
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Hiding and un-hiding rows

e Open afile called Hide.

e Click the row heading to select the row you wish to hide. Highlight other rows by
pressing Ctrl while you click on each row heading. In this case, select the row

relating to Carla. Right click on the selected row and from the popup menu
displayed select the Hide command.

[ A ] B | C | D | E |
1 ) < -
2 Salesperson Sales for Arial AN S % 0 for 2007
3 |Sue 33, - O - Aol g 20,558
4 Nyah 31967 J3.586 33586 72069
5 ICara 29.9 34,475
6 Rowan T3k 23.856
7 Gina 30,4 =2 Lopy 44,586
8 | Shrikrishna 30,2 @& | paste 52586
9 Kayo 29.8 Paste Specia 34,496
10 —
11 Insert
12 Delete
13 Clear Contents
14
15 |§' Format Cells...
16 Row Height...
7 Hide
18 )
19 Unhide

e The selected row is now hidden. As you can see Carla’s details are no longer
displayed.

A B C D E
1
2 |Salesperson Sales for 2004 Sales for 2005 Sales for 2006 Sales for 2007
3 Sue 33,985 34,858 20,576 20,558
4 Nyah 31,984 33,586 33,586 72,069
6 Rowan 39,375 43,856 42 586 43,856
T |Gina 30,447 36,886 36,586 44 586

30,274
29,844

23.857
20,485

FOR USE AT THE LICENSED SITE(S) ONLY
© Cheltenham Courseware Pty. Ltd. 1995-2010 www.cheltenhamcourseware.com.au



Excel 2007 Inter mediate - Page 32

A B | c | D | E |
1
2 Salespersid 10 TAT AT S 7% 0 "y:sfurZDDB Sales for 2007
3 Sue 20576 20 558
4 |Myah : 33.586 72,069
6 |Rowan aeams s 42 586 43,856
7 Gina & cut T 36586 44 586
_ & | Shrikrishn B3 copy 63,968 52 586
9 |Kayo [, Paste 30,885 34,496
% Paste Special...
E Insert
i Delete
% Clear Contents
E @ Format Cells...
i Row Height...
% Hide
20 | Unhide
21

Hiding and un-hiding columns

Select the column you wish to hide, in this case the column relating to Sales for
2005. Right click over the selected column and from the popup menu displayed,
select the Hide command.

0 - K% o T
BEJELD-S-A-"2580

LAl A B I_ll— Arial

1

2 Salesperson Sales for 2004) Sales

3 |Sue EELTT

4 |Nyah 31,984 el cu

5 Carla o | *

6 |Rowan 38,375 "l Loox

7 |Gina 447 @ Baste

_ 8 Shrknzhna 30,274 | Paste Specal...
3 | Kayn 79 Bad

T Insert

F: Delete

Az | Clear Copjtents
1

_3' j Ecamal Celli...
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A B D E

1

2 |Salesperson Sales for 2004 Sales for 2006 Sales for 2007
3 |Sue 33.985 20576 20,558
4 Nyah 31,984 33,586 72,069
5 Carla 29,948 20,586 34,475
6 |Rowan 39,375 42 586 43,856
7 |Gina 30,447 36,586 44 586
& | Shrikrishna 30,274 63,968 52 586
9 Kayo 29,844 30,885 34,496

=1
=

e To unhide the column, select the columns on either side of the hidden column and
right click over the selected column. From the popup menu displayed select the
Unhide command.

e Experimenta little more with hiding and un-hiding rows and columns. When you are
finished, save your changes and close your workbook.

Hiding / un-hiding worksheets

Hiding and un-hiding worksheets
e Open a workbook called Worksheet.

¢ Rightclick on the sheet tab to select the sheet you wish to hide, in this case Sheet
2. From the popup menu displayed select the Hide command.

s T Y

17 Myah Insert...
18 Carla

19 Rowan LEriE
20 Gina Bename

Shrikrishna
Kayo

23|

4

26
27

M 4 » v | Sheetl | Sh
Ready = |

e Sheet2 will now be hidden, as illustrated.
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4 4 » M| Sheetl | Sheet.'}{m
Ready | [ |

To unhide the worksheet, right click on one of the worksheet tabs and from the
popup menu displayed, select the Unhide command.

-
=]

Insert...

Delete

Eename

Move or Copy...
G | View Code
{3}y Protect Sheet..

Tab Color L3

Hide
| Unhide.. I

BEENEREERNEE
(=R =R N A= R SR S Y] —= o |w

Select All Sheets

4 4 » M| Sheetl | Sh
Ready | 1 |

You will see a dialog box displayed from which you can select the hidden sheet you
wish to unhide.

Unhide

nhide sheet:

| now be dis in.

et

£33

M 4 » M| sheetl | Sheet2 ~sheet3 ~¥J

Ready = [ |

Experiment with hiding another worksheet and then save your changes and close
the workbook.
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Sorting and Querying Data

Sorting data by multiple columns

Sorting internal Excel databases
e Open afile called Sort data 01.

e Inthis example, we wish to sort the data by second name, and then by first name.
As you can see, there are three people with the last name Gutierrez.

e Click within the Second _name column of data:

A | B | C |

1 |First Name Second name  Department

2 |Elliat =mith Marketing

3 |Rob Jones Marketing

4 |Peter Hague Froduction

5 |Sue Major Froduction

6 |Dave hlurray Sales

7 |Lou Feters Sales

g |Fobin =mith Sales

9 |Tim =mith Sales

¢ Click on the Data tab and from within the Sort & Hlter group click on the Sort icon.

i Data | Review View Developer
Zonnections Ny ?’ & Clear
£¥||Z|A 7
‘raperties | o Reapply
Zl Sort Filter
sdit Links A W ndvanced

Sort & Filter

SAMPLE
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This will display the Sort dialog box:

Sort @
[ | Add Level H ¥ Delete Level ] [ 153 Copy Level J| & || @ My data has headers

Caolumn Sort On Order
Sort by | v| |'I.|'alues v| |At02 L

| ok ] | cancel ]

Click on the down arrow to the right of the Sort by section of the dialog box and
select Second_name.

3
] [ “"'é[ Add Level ” X Delete Level ][ 23 Copy Level ” i || ¥ || Options... My data has headers
E
9 | Column Sort On Order
Sortby [w] |'u'a|ues v| |.At02 w
First Mame
Department
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Order
v| Az vl
AtoZ

ZioA
Custom List...

e Click on the Add Level button.

I “‘";1 Add Level H X Delete

Column
Sort by

You will see a Then by section added to the dialog box.

:‘j'fl Add Level [ X Delete Level ] [ 53 Copy Level ]| . My data has headers
Ord

Calurnn Sort On 2
Sort by |5emnd_name w | |'u’alues b | |"!'L to & i |
Then by | v| |'|.-'alues V| |""13‘:‘2 v|

Cancel

by section
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i

e
i [ "}%1 Add Level ” X Delete Level ]E
3
= | Column :
Sortby |Semnd_name w | |:
Then by m“
First Mame ]
Second_name
Department

e Make sure thatthe A-Z option button is marked within the Order section of the
dialog box.

e Click on the OK button and the data will be sorted by second name and then by first
name, as illustrated:

i D19 v (2 £ |

A B E D
1 | First_Name Second_name Department
2 Meil Abercrombie Marketing
3 Gary Ackerman Marketing
4 |Elijah Cummings Production
5 |Ciro Gutierrez Sales
6 |Luis Gutierrez Production
7 |Zoe Gutierrez Sales
8 |Joe Knollenberg Sales
9 Marilyn Musgrave Sales

&
2

e Save your changes and close the workbook.

Custom sorts

or a small
pecific da

that leave o of the

e week, but
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E18 -Q £ |
A | B |
1 Country Day flights Available
-2 Tuvalu Friday
3 |Uruguay Friday
4 Yugoslavia Friday
5 Yemen Manday
B | Turkey Monday
7 |Uganda Thursday
@ Venezuela Thursday
9 |Zaire Thursday
10 |Zambia Thursday
11 |Ukraine Tuesday
12 \Vanuatu Tuesday
13 Western Sahara Tuesday
14 Turkmenistan Wednesday
15 |United Arab Emirates Wednesday
16 Uzbekistan Wednesday
A7 Vietnam Wednesday
18

e Whatwe wantis the list sorted so that we see Monday’s flights listed first, then
Tuesday's and so on. To do this we need to perform a custom sort.

e Click on a cell within the Day flights Available column.

e Click on the Data tab and from within the Sort & Fiter group click on the Sort icon.

| Data l Review View Developer
Connections || 4 ; (< Clear |
e % k
Properties = Reapply
il Sort Filter 1
Edit Links . W Advanced || ¢
sctions Sort & Filter I

Sd;pay SO\” dM
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[ ‘-’51 Add Level ] [ X Delete Level ] [ 53 Copy Level ]| & || ¥ My data has headers

Caolumn Sort On Order

Sort by |Day flights Available | |'u'a|ues w | |A toZ w
Lok | [ canca |

e Click on down arrow within the Sort by section of the dialog box, and select Day
flights Available.

e Click on down arrow within the Order section of the dialog box, and select Custom
List.

[ ‘-’51 Add Level ” X Delete Level ” 53 Copy Level ]| & || & My data has headers

Column Sort On Order

Sort by |Day flights Available s | |'I.|'alues w | AtoZ vl
Ao Z
Z1ioA

. Select the option
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Custom Lists

Custom Lisks |

Cuskaom lisks: List entries:
MEWY LIST Suriday Add

sun, Mon, Tue, Wed, Thu, Fri, = Mondas
Mondat, Tuesday, 23,

Jan, Feb, Mar, fpr, May, Jun, ]
January, February, March, April

Press Enker ko separate lisk entries,

L ] 4 ] [ Cancel ]

e Click on the OK button and close all open dialog boxes. The list will then be sorted
by weekday, as illustrated.

A | B |
1 |Country Day flights Available
2 |Yemen Monday
3 Turkey Monday
4 Ukraine Tuesday
5 Vanuatu Tuesday
B Western Sahara Tuesday
7 Turkmenistan Wednesday

Uruguay Friday
Yugoslavia Friday

e Save your changes and close the workbook.

Using AutoFilter
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Using AutoFilter to query data
e Open a workbook called Autofilter 01.

e Click on any cell within the list.
e Click on the Data tab and from within the Sort & Rlter group click on the Hlter icon.

| Data | Review Wiew Developer
innections Al & Clear I
operties {}- Reapply
z l Sort || Filter
it Links Ly {7 Advanced
tions | Sort & Filter |

The table will then look like this.

G16 - 5|
A | B | C |

1 | 5ales_Person t] Region \LJ Units_SdLJ
-2 |Sue Morth

3 |Nyah South 16
4 Carla South 20
5 Rowan Marth 27
6 Lou South 13
7 Shrikrishna South 15
8 Kayo Morth 10
-9 Dave Morth 12
10 Bob Morth ]
11 | Gina South 18

12

e We can click on the down arrows displayed to applyfilters to the data. Click on the
down arrow at the top of the Region column, and you will see the following.

SAMPLE
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G16 - £ |
A | B | [ | b | E

1 |Sales Person |~ Region |+ Units_Sd = |
4] sotatez 14
Z) seriztoa ;g
Sort by Color | 27
W | Clear Filter From “Region | 13
Filter by Color L | 13
Text Filters L3 | 12
] (Select Al i 9
Morth | 18

[ South

Lok | [ cancer ||

gl

e De-=sselect Select All and then select North, as illustrated, and click on the OK button.

Text Filters 4

e You will now only see details relating to the North region.
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Multiple queries

e So far, we have filtered the data to show only sales in the North region. We can
now add a second filter to show only sales in the North region, over a certain
amount, say 11.

e To do this, click on the down arrow in the Units_Sold column and select Number
Filters. From the submenu displayed select Greater Than.

B4 - f« | South
A B C D E F G
1 Sales Person |~ Region Units SB
2 |Sue %1 sort smallest to Largest
5 |Rowan z
5ort Largest to Smallest
8 Kayo &) s ?
9 Dave Sort by Color 4
10 |Bob % | Clear Filter From "Units_Sold
12 Filter by Cola 4
13
14 Mumber Filters » Equals...
15 o] (Select All) Does Mot Equal...
16 :
| Greater Than... Ik
17 ¥ 10
18 ¥ 12 Greater Than Or Equal To...
19 14 Less Than...
;3 ey Less Than Or Egual To...
29 Between...
23 Top 10...
?51 Above Average
26 [ ok || cancel Below Average
27 i Custom Filter...
28

e This will display the Custom Autofilter dialog box. Enter the number 11, as
illustrated and click on the OK button.

Ise 7 ko represent any single characker
Ilse * ko represent any series of characters

[ Ok J[ Cancel ]
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e The data will now be displayed as illustrated below. Only sales above 11 within the
North region will be displayed.

B4 - f« | South
A | B | C |
1 |Sales_Person |~ |Region |7 Units_Sd-7|
_2 |Sue MNorth 14
_ & |Rowan Morth 27
_9 Dave Morth 12

Removing filters
e Toremove the filter re-click on the Hlter icon.

B pats, RIS

iew View Developer
| Connections ﬁl Bzl i, Clear
| £¥ |Z|A

'Properties [ {'} Reapply
zl sort Filter 7
Edit Links A f O advanced
ections Sort & Filter [

e Save your changes and close the workbook.

Top 10 AutoFilter
e Open a workbook called Autofilter 02.

Click on any cell within the list.
Click on the Data tab and from within the Sort & Hlter group click on the FHlter icon.
You will see drop down arrows applied to the top of each column of data.

. ick on the down arrow inthe Units_Sold ¢ lick on.the Numb
the su u disp ds 10 command.
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ca - (- fe | 20
A B | c | b | E | F |
1 |Sales Person |~ |Region |+ Units_Sd ~ |
2 Sue ‘%l Sort Smallest to Largest
3 Myah z
— Sort Largest to Smallest
4 Carla al
5 |Rowan Sort by Color 4
6 Lou ¥ | Clear Filter From “Units_Sold
[ Sheikishna Filter by Color g
8 Kayo
9 |Dave Mumber Filters » Equals...
10 |Bob -] (Select Al A Does Mot Equal...
11 Gina il
— vl 9 Greater Than...
12 [ 10
13 -] 12 Greater Than Or Equal To...
14 [ 13 = Less Than...
] 14
% 15 Less Than Or Egual To...
? [ 18 Between...
18 18 =l Top 10...
19 A |
ﬁ — __ Above Average
? [ 0K J [ Cancel J Below Average
22 . Custom Filter...
23 '
24

e This will displaythe Top 10 AutoFilter dialog box. Type in the number 5, as
illustrated and click on the OK button.

Top 10 AutoFilter

Shrikrishna South 15
Gina South 18

¢ |If you wish you cansortthese, by clicking on the A-Z Sort icon within the Sort &
Filter group of the Data tab.

FOR USE AT THE LICENSED SITE(S) ONLY
© Cheltenham Courseware Pty. Ltd. 1995-2010 www.cheltenhamcourseware.com.au



Excel 2007 Inter mediate - Page 47

| Data | Review WView Developer
nnections || (4 f “f Clear
AlZ
ons | [34) !
perties | b | % Reapply
ZJ, sort Filter
t Links A \[;,, Advanced
ans Sort & Filter

e The data will now look like this.

| F28 - % |
A B C
1 Sales_Person M Region |L| Units_ Sdﬂ
3 |Shrikrishna South 15
4 Myah South 16
5 |Gina South 18
7 |Carla South 20
11 |Rowan Marth 27

e Save your changes and close the workbook.

Using advanced query / filter options

Filtering unique records

e Open a workbook called Advanced filter. This contains a list of names with
company ID numbers. If you look carefully you can see a duplicate, i.e. Carla is
listed twice. In this case, the listis so small that looking for duplicates is easy, but
justimagine trying to do this for a list of thousands of names. We wish to filter this
list to avoid duplicates.

hen click on'the D tab and from within
ced button.

e The Advanced Fiter dialog boxis displayed.

operties
fit Links ‘

lions

Filter

L_‘%r Advanced |
Sort & Filter
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Advanced Filter

Action
(%) Filter the lisk, in-place
) Copy to another location

List range: |$.ﬁ.$1 fE$1Z

Criteria range: |

Copy o |

[ JiUnique records only:

[ K, J’ Cancel ]

Click on Unigue records only, and then click on the OK button.

[ ]9 ][ Cancel ]

We will now see the list displayed without any duplicates. Carla is only listed once.

| F22 - fx |
A B C
1 MName Company ID Number
2 Sue 1187
3 |Carla 1738
4 |Rowan 2184
5 Dave 2647
6 | Shrikrishna 2647
T Kayo 2765

SAMPLE

Advanced Filter
Open a workbook called Advanced Flter Criteria. This workbook contains a simple
sales list. We wish to filter the list so only sales made by Gina to Germany are
displayed. Soitis easier to see, we have highlighted all sales by Gina, who made
two sales to Germany and one to South Africa.
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e Enter the following (i.e. "Gina" and "Germany") into the criteria area beneath the list:

24

25 | Month Sales Person Country Amount
26 Gina Germany

27

e Selecta cell within the Sales Person list.
e Click on the Data tab and from within the Sort & Riter group click on the Advanced

button.
| Data | Review View Developer
nnections Al H r { Clear
operties | ,F!eapply
J, Sort Filter |-
fit Links A | '-‘:)Aduanl:ed|
fons Sort & Filter

e The Advanced Flter dialog is displayed. Excel should have automatically entered
your listrange into the List range box.

Advanced Filter

Sckian
(%) Fileer the list, in-place
) Copy to anather location

Criteria range; | et vt v
Copy ko | E |

[] Unigue records only

List range:

A25:D26, solclick within the Criteria
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Advanced Filter

Ackion
(%) Filter the list, in-place
() Copy ko another location

List range: |$P.$3:$D$2EI
Criteria range: |$P.$25:$D$26 _
Zopy ko | R |

[ Unigue records only

L Ok J[ Cancel J

e Click on the OK button and Excel will filter the list, showing only records that match
your criteria.

]

A | B | c . D |

1 Sales Figures
2
Z Month Sales Person Country Amount
6 |June Gina Germany 4000
10 |February Gina Germany 3421
21
22 TOTAL 107133
23|
24
25 Month Sales Person Country Amount
26 | Gina Germany
27
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Linking & Consolidating Data

Linking data or a chart within a worksheet

Linking individual cells within a worksheet

Open a workbook called Link worksheet data.

NOTE: Please be careful to open the file called Link worksheet data,
not a file called Link workbook data.

In this worksheet, the postage and packing cost is stored in cell A3.

Click on cell C7 and add the following formula: =$A$3

Copythis formula to cells C8:C11 (byclicking on cell C7, moving the pointer the
bottom-right of the cell, until the mouse pointer changes to the shape of a small

cross, and then drag down to cell C11). The worksheetshould then resemble the
illustration shown:

A B C . D
1
2 Postage and packing
3 25
4
5
6 Stock Number Sale price Postage and packing Total price
7 10945 20.76 25 2326
8 10748 18.64 25 2114
9 10847 12.99 25 15.49
10 10884 13.74 25 16.24
i 10385 13.99 25 16.49

Click on cell A8 and change the value'from 2.5to 3.0. This should automatically
change the data in'the Postage and packing column data. This demonstrates the
advantage of linking data -/it saves the time it wouldtake to change each value
individually.

Save your/changes and close the workbook.

Linking charts to data within a worksheet

Open a workbook called Link worksheet chart.

When you select data within a worksheet and create a chart from this, by default the
chartis automatically linked to the data. Any changes made to the data that the
chart was based on, will be reflected in the chart.

Click within the data.
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e Click on the Insert tab and from within the Charts group click on the Column icon.

| Insert | Page Layout Formulas Data Review View Developer

1 B8 D gl ik @ =y )

e Picture Clip Shapes Smarb‘\rt‘ Column| Line Pie Bar Area Scatter Other

Art ) b - - Charts -
i:_ Tliustrations | Charts {F]

e This will display a drop down list of chart options. Click on the first 2-D chart option

illustrated.
Ca’ )= ) Link worksheet chart.xlsg - |
iR Ee——— ——
- Home | Insert | Page Layout Formulas (] Review View Develo

I B ol B P 2 (gl i @ ol

PivotTable Table |P‘i€f.'l.ilE Clip Shapes 5ma.rtﬂrt:|tﬁlumn Line Pie Bar Area Scatie
|

- Art - i = - - - - -
Tables | ) Tustrations 1 | 2-p Column
c3 - (s A EEEE el
" B [ 'ih |M Eﬂ
1| —_—
2 | Region Sales for 2005 Sales for | 3D Column '
3| North 23,989 25 371 _ l
DE O g e
5
6| Culinder

M North
W south

Salesfor 2005 Salesfor 2006
Tk <k

e Change the sales values for the North or South regions and the chart will
automatically update to reflect these changes.
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30,000

25,000 -

20,000

15,000 4 B Morth

W South
10,000 -

5,000 -

Sales for 2005 Salesfor 2006

e Save your changes and close the workbook.

Linking data or a chart between worksheets [within aworkbook]

Linking a cell range on one worksheet to another worksheet
(within the same workbook)

e Open aworkbook called Link data between worksheets. This workbook contains
two page tabs. Note that postage and packing value is stored on the second sheet.

¢ In this example, we will link the Postage and packing value on the second
worksheet to a cell within the first worksheet of the workbook.

e Click on cell C4 on the first worksheet.
in the equails sign (=)

the workbook)

8 within this cell:
| c4 - S | ='Postage and packing'lad
A B | C | D
1
2
3 Stock Number Sale price Postage and packing Total price
4 10945 20.76 | 2.50 I 2326
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¢ You have linked data from one worksheet to another worksheet. Notice the syntax
in cell A4. You can use the help within Excel to get more information. Save your
changes and close the workbook

Linking data on one worksheet to a chart in another
worksheet (within the same workbook)
e Open a workbook called Link chart between worksheets.

NOTE: Be careful not to open a different file called
Link chart between workBOOKS

e Click on the worksheet tab called Chart. You should now be viewing an empty
worksheet.

e Click on the Insert tab and from within the Charts group click on the Column
button. Selectthe first chart within the 2-D options.

ﬂmo}&p

rt olumn| Ling Pig Bar Area Scatter
= 2-D Column
3-D Column

e You will see an empty chart placeholder displayed within your worksheet. Right click
on this empty chart placeholder and you will see a popup menu displayed. Click on
the Select Data command.

Match Style

Chart Type...

Assign Macro...

% Format Chart Area...
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e This will display the Select Data Source dialog box.

Select Data Source

Chart data range: | hark!$E$20
Poea— -, | [
{1 i |
Legend Entries (Series) Horizontal (Cateqory) Axis Labels
[ ‘Eﬁdd ] EH Edit X Remove || @ || @ EH Edit
’_ Hidden and Empty Cells ] [ Ok J [ Cancel ]

e Click on the Data worksheet tab (bottom-left of your screen).

24

30

M 4 » M| Data - Chart ?ﬁ; |
Ready | 7 |

e Selectthe table of data.

NOTE: You may have to move the dialog box so that you can select the data.

= A B C D E = G H 2 K
1]
2 |
*  —————— [ R—————— R ———— ]
4 1 Sales Region Sales for 2005 Sales for 2006
28,576
v} Axis Labels
7|
18 | -
n o] Ceme ]
20 |

e Click on the OK button and the chart will be displayed on the second worksheet,
using that data you selected on the first worksheet.
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e Try altering the data on the first worksheet and if you switch to the second
worksheet, you should find that the chart has changed to reflect your changes.

e Save and close your workbook.

SAMPLE
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End of the preview sample

‘ CHELTENHAM
|

This sample is approximately half of the full course. Please see the table of contents at
the beginning of this document to see the full list of topics covered in the full course.

To purchase the rights to use the full training manuals at your training centre please see
our web site at:

http:/MWwww .cheltenhamcourseware.com

A courseware licence allows you to make unlimited copies for use at your training
centre.

The IT Computer Courseware Library

A complete library of quality training courses Q

Includes Windows 7 and Office 2010 Courseware j & \

* GET THE RIGHTS TO A COMPLETE LIBRARY OF TRAINING COURSES INCLUDING ALL THE MAJOR APPLICATIONS
* HIGH QUALITY, LOW COST COURSES * ADD YOUR OWHN MAME AND LOGOS
* PRINT AS MANY COPIES AS YOU NEED » INTRAMET VERSION ALSO AVAILABLE

In addition you get HTML formatted versions of each

course, included with our printable courseware. OVer

lmvestina complete Computer Courseware 7 000 '~
Library, including Windows 7 & Office 2010 : Y :
Theymost cost effective courseware solution for your IT Web Pages

training needs. Get ALL our caurses, and all hew

ey Incl h h
courses released within 12 months ! neludgy when you pgighase

the 'IT Courseware Library'.
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